
 
 

  حسن بن عبد القادر رشو: إعداد
 

 ةمقدم
 

 ٢٠٠٠معلومــــــات مهمة حول الفرونت بيج 
 :ترميز الصفحة إلى العربية  تغيير ##

البحث  ترميز صفحة الويب إلى العربية حتى لا تواجه مشاآل أثناء تصميمها ولكي تسهل محرآات يجب تغيير
 : وذلك آالتالي .... في العثور عليها عند البحث عن المواقع العربية

 .افتح صفحة جديدة  -1
 .من القائمة  Page Properties الفأرة في أي مكان في الصفحة واختر اضغط بيمين -2
 . Language من الأعلى اضغط على علامة التبويب -3
 .اسم دولتك + الخيار الأول على العربية  اجعل -4
 . Arabic والثالث اجعل الخيار الثاني -5
 .ثم ابدأ العمل في الصفحة  OK ضغطا -6

 : ) انجليزي -عربي ( جعل الصفحة منسقة عند آتابة نص عربي أو نص مختلط  آيفية ##

 Lift" لليمين  أي صفحة جديدة تقوم بفتحها أنها مناسبة للنص المكتوب من اليسار٢٠٠٠الفرونت بيج  يفترض
To Right" تحويل اتجاه النص إلى لذا يجب علينا.. ر والنص العربي آما تعلم من اليمين لليسا "Right To 

Lift" وذلك بأحد الخيارات التالية : 
في أسفل الفرونت  HTML وذلك من قسم . <html dir=rtl> إلى <html> تغيير وسم بداية الصفحة من -1

 .  آما ذآرنا في الدرس الأول٢٠٠٠بيج 
 . <body dir=rtl> لىإ <body> أو تغيير وسم بداية منطقة الجسم من -2
اليمين إلى اليسار عند  في الخيارين السابقين ستلاحظ انتقال شريط التمرير الرأسي من ] : ملاحظة *

 . [ معاينة الصفحة في الفرونت بيج أو في المتصفح
النص إلى العربية في النص المكتوب  أو باستخدام الجداول لتنظيم الصفحة ، حيث يمكنك تغيير اتجاه -3
 . <table dir=rtl> إلى <table> من خل الجدول فقط ، وذلك بتغيير وسم بداية الجدولدا

 . <td dir=rtl> إلى <td> خلية واحدة فقط من خلايا الجدول ، وذلك بتغيير وسم بداية الخلية من أو تغيير -4
انجليزي في أحد خلايالليسار وتريد أن تضع نص  وهذا سيفيدك إذا آان اتجاه النص لكامل الصفحة من اليمين

 . <td dir=ltr> آل ما عليك هو جعل وسم بداية الخلية الجدول وجعله أآثر تنظيماً ، حيث أن
 ، <p dir=rtl> إلى <p> أو تغيير اتجاه النص لمقطع أو فقرة محددة وذلك بتغيير وسم بداية الفقرة من -5

ثل النص الانجليزي بحيث يصبح وسم بداية ذآره م وهو سيفيدك في تنسيق نص من اليسار لليمين السابق
 . <p dir=rtl> وليس <p dir=ltr> النص الانجليزي في صفحة عربية هو

  . [ dir تذآر دائماً المسافة قبل آتابة : [ملاحظـــــة  ***

  :آما في ميكروسوفت وورد  ضبط نص ##

أحد الأوامر  إلى <p> بداية الفقرة منجميع أسطر نص معين مكتوب في فقرة واحدة ، غير وسم  لضبط نهاية
 :التالية 

1- <P dir="rtl" style="TEXT-ALIGN: justify"> . 
 2- <P dir="rtl" style=" TEXT-ALIGN: justify; TEXT-JUSTIFY: inter-word"> . 
 3- <P dir="rtl" style=" TEXT-ALIGN: justify; TEXT-JUSTIFY: newspaper"> .  
4- <P dir="rtl" style=" TEXT-ALIGN: justify; TEXT-JUSTIFY: kashida"> .  

 1



   :٢٠٠٠وضع عدة ارتباطات في صورة واحدة بواسطة الفرونت بيج  طريقة ##

 .في الصفحة  أدرج الصورة -1
 . سيظهر في الأسفل شريط أدوات الصورة... أشر على الصورة بالفأرة  -2
اضغط ما تريد منها واصنع شكل حول أي جزء من  ستجد في الشريط ثلاثة أشكال هي -3

 .الصورة تريده أن يصبح ارتباط 
ضع الارتباط  ، Create Hyberlink بعد أن تكمل وضع الشكل في الصورة سيفتح مربع حوار وضع الارتباط -4

  . OK الذي تريد واضغط

ارتباط نصي ، يظهر عند مرور الفأرة على صورة أو على ارتباط نصي مثل لوضع نص ## : 

عدم ظهور الصورة أو للشرح حول ما  عند المرور على الصورة ، وهو يستخدم آنص بديل عند نص يظهر  )أ
  :تهدف إليه الصورة ، ويتم عمله آالتالي 

 .الصورة في الصفحة  أدرج -1
 . Picture Properties القائمة اضغط على الصورة بيمين الفأرة واختر من -2
 . OK الذي تريد ثم اضغط النص Text اآتب في خانة -3
  :نص عند مرور الفأرة على ارتباط نصي  -ب

 . ظلل على النص المطلوب -1
  .٢٠٠٠في أسفل الفرونت بيج  HTML افتح قسم -2
   :ستجد الشفرة الخاصة بهذا النص مظللة ، أضف لها الشفرة التالية  -3

title=""ضع النص هنا
إذا آان الكود الأصلي لهذا الارتباط هو  :مثال

<p><a href="http://www.hi4net.com/index.htm">الرئيسية الصفحة</a></p>
 فإن الكود بعد الإضافة سيصبح

<p><a href="http://www.hi4net.com/index.htm" title="الصفحة الرئيسية<هنا" ضع النص</a></p>

 :عن مايسبقها أو ما يليها  تقارب وتباعد الأسطر ##

أو خلايا الجداول أآثر أو أقل تقارباً أو تباعداً   يمكنك جعل الأسطر أو الصور أو النماذج٢٠٠٠بواسطة فرونت بيج 
 :وذلك آالتالي  ...عن ما يسبقها أو ما يليها 

 . Paragraph واختر Format افتح قائمة -1
 :التقارب أو التباعد حيث أن  يمكنك تعديل Spacing من خانة ... Paragraph سيفتح مربع حوار -2
 . خاص بتغيير مسافة ما يسبقه : Before )أ
 . خاص بتغيير مسافة ما يليه : After )ب

  :٢٠٠٠نقل صفحاتك إلى موقعك في الشبكة بواسطة فرونت بيج  ##

 :وذلك آالتالي  ftp أو برنامج يمكنك نشر صفحتك بواسطة فرونت بيج بدلاً من استخدام المتصفح
 . Publish Web على واضغط File افتح قائمة -1
موقعك آاملاً ، وإن اردت ارسال الصفحات لمجلد معين فاآتب أيضا اسم هذا  اآتب في الأعلى عنوان -2

 . http://www.hi4net.com/HTML المجلد مثل
 .الأسفل  في Publish اضغط زر -3
  . OK المرور الخاصة بموقعك ثم اضغط ستخدم وآلمةسيفتح مربع ، اآتب فيه اسم الم -4

 :لبريدك  لتحديد عنوان الرسالة عند ضغط الزائر على ارتباط

 . "اتصل بنا " مثل ..ظلل النص الذي تريده ارتباط لبريدك  -1
 . "Create Hyperlink " افتح مربع حوار إنشاء الارتباط -2
 :الرسالة  عنوان بريدك وعنواناآتب التالي ، مع تغيير  URL في خانة -3
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http:///


 
 
 
 
 
 

 الأول الدرس

 
 

 . إلخ..  ثقافي - تعليم - برامج -تصميم موقعك عليك تحديد موضوعه هل هو شخصي  قبل البدء في :أولا 
  اللازمة لتصميم صفحات الويب ؟ ماهي البرامج :ثانياً 

النصوص التي  ويتم استخدامها لتحرير... بويندوز وهي موجودة ضمن البرامج الملحقة  : ( Notepad ) المفكرة -1
 .ستضعها في موقعك ومن ثم نسخها ولصقها في الفرونت بيج 

وهو موضوع شرحنا ، وقد اخترناه لأنه من عائلة ميكروسوفت:(FrontPage) ٢٠٠٠مايكروسوفت فرونت بيج  -2
أن تصمم  وهو برنامج قوي تستطيع. امه اعتاد الكل تقريبا على استخدامها وهذا سيسهل من استخد أوفيس التي

وهو غير ( آما ذآرنا  ٢٠٠٠ويوجد هذا البرنامج ضمن مجموعة أوفيس . صفحات بمستوى احترافي بواسطته 
 ) .معّرب 

 :البرامج ما يلي  ومن هذه. إلخ .. لإضافة لمسات جمالية للصفحة آالخلفيات والعناوين  :برنامج رسومي  -3
 (Photo Shop) فوتوشوب *

 (Paint Shop Pro) بينت شوب *
 (Flash) فلاش *

  الرسام المرفق بويندوز *
 . أو أي برنامج رسومي آخر تجيد استخدامه

 . وسيكون هناك دروس لبعض هذه البرامج في الموقع بمشيئة االله

  :٢٠٠٠بيج  تعّرف على واجهة فرونت #
  د هذه المعلومة عن صفحة الويبالبرنامج وأدواته نور ولكن قبل البدء في شرح رموز

 . <html/> وتنتهي بـالوسم <html> أو الإتش تي ام ال بـالوسم html تبدأ صفحة *
  :تنقسم الصفحة إلى منطقتين هما  *

.وتحتوي على عنوان الصفحة  <head/> وتنتهي بـالوسم <head> وتبدأ بـالوسم :الهيد منطقة الرأس أو -1
وآل ما سيظهر في الصفحة  .. <body/> و <body> وتقع بين الوسمين :ديالبو منطقة الجسم أو -2

 .المنطقة  سيكون موجود في هذه
 / Normal ثلاث قسام هي  ، ستجد أن الإطار أسفل البرنامج يحتوي على٢٠٠٠والآن افتح الفرونت بيج

HTML / Preview . 
 .هو منطقة العمل التي سيترآز فيها شرحنا  : Normal القسم *
 . لمشاهدة الكود الذي يكتبه البرنامج خلف الصفحة : HTML لقسما *
لذلك بعد أن تضيف شيء للصفحة في .. للمتصفح  لمشاهدة الصفحة آما ستظهر : Preview القسم *

 . Preview منطقة قم بمشاهدة طريقة ظهوره في Normal قسم
  :٢٠٠٠رموز أشرطة أدوات فرونت بيج  إليك الآن شرح أهم *

 

 
  الأول انتهى الدرس
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ني الدرس الثا 

 : استخدام فرونت بيج #

 :  ابدأ التنفيذ الآن٢٠٠٠بعد أن حددت موضوع موقعك وتعرفت على واجهة فرونت بيج 
 ؟ آيف... حدد خصائص الصفحة : أولاً 

ستظهر لك النافذة  Page Properties من القائمة المنسدلة في أي مكان فارغ في الصفحة اضغط يمين الفارة واختر
 : التالية

 
 : ستظهر لك النافذة التالية Background اضغط في الأعلى على علامة التبويب بعد ذلك... حدد ما تريد
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 . OK حدد ما تريد ثم اضغط

 آيف ؟.... الصفحة وإدراج الصور وعمل الارتباطات بين الصفحات  ابدأ بتحرير: ثانياً 
ثم ابدأ ) وسط أويمين أو يسار ( المؤشر في أي سطر تريد وفي أي جههة  ضع :لإدراج نص في الصفحة  *

 . بالكتابة

 الانتقال للسطر التالي لإآمال الجملة السابقة بالضغط على عند الكتابة في الفرونت بيج وأردت : ملاحظة ]
Enter بين السطور ولكن اضغط ستكون المسافة آبيرة ( Shift+Enter ) .  ] 

د ذلك اختر الصورةبع From File ستفتح قائمة اختر منها Picture ثم اختر Insert افتح القائمة :لإدراج صورة  *
 . OK واضغط التي تريدها

أو لمستند وورد أو لأي  لوضع وصلة أو ارتباط أو لنك أو حسب ما تسميها ، تنقلك لصفحة أخرى أو لصورة *
  :ملف عند الضغط عليها 

 " .اضغط هنا"لمشاهدة صفحتي الشخصية .. مثلاً  :اآتب اسم الارتباط  -1
 .ملة التي تريدها أن تصبح ارتباط لصفحتك الشخصية وهي الج" .. هنا  اضغط"ظلل  -2
النافذة  ستظهر لك.. في لوحة المفاتيح  Ctrl+K أو اضغط Hyperlink واختر منها Insert القائمة افتح -3

   التالية

 
وهذا سيسهل عمل ارتباط إلى هذه  .. في هذه المساحة ستظهر الصفحات التي قمت بحفظها : (1)

وستكتب مباشرة في " اضغط هنا " ربطها بجملة  فقط أشر بالماوس على الصفحة التي تريد.. الصفحات 
 . OK ، ثم اضغط) ٢(الخانة 
 . (.htm) وهو مع امتدادهافي هذه الخانة يمكنك آتابة اسم الصفحة مباشرة  : (2)
يمكنك من خلالها أن تستعرض مجلدات وملفات جهازك  بالضغط على هذا الرمز ستفتح لك نافذة جديدة : (3)

 .المظللة في الصفحة  واختيار ما شئت لتربطه بالجملة
ى الوصلة في عند الضغط عل.. نافذه لعمل ارتباط إلى بريد إلكتروني  بالضغط على هذا الرمز ستفتح لك : (4)

 برنامج البريد الإلكتروني الافتراضي للشخص المتصفح ليرسل لك رسالة على العنوان التي المتصفح يفتح
 .ستكتبه في هذه النافذة 

 . OK اضغط "اضغط هنا " بعد أن تختار نوع الملف الذي ستربطه بجملة 
 .أخرى أو لملف آخر  صفحةأصبح تحتها خط أي أنها أصبحت ارتباط ل" اضغط هنا"ستلاحظ أن جملة 

 . [!!جرب عمل وصلة أخرى لملف من نوع آخر .. جميع الارتباطات في موقعك  وبنفس الطريقة تقوم بعمل ]
 zip أو exe فمثلاً البرامج تكون عادة بامتداد... الاسم مع امتداد الملف  لاحظ أن الارتباط يجب ان يكتب فيه** 

ارتباط لتحميل  فمثلاً لو اردت عمل... اذا رغبت عمل صفحة برامج مجانية عليك آتابة هذا الامتداد  لذا يجب
وهكذا لبقية الملفات exe. mIRC  ، :يجب ان يكون الارتباط آالتالي  exe وامتداده هو mIRC برنامج باسم

 .باختلاف امتداداتها 

 وبقية ملفاتي في الجهاز ؟؟؟ آيف سأحفظ صفحاتي #
 . gif أو jpg ستستخدمها في موقعك بأحد الامتدادين قم بحفظ الصور التي -1
 .دقتها  للمناظر الطبيعية أو الصور التي لا تقبل تقليل ألوانها حتى لا تفسد jpg امتداد حيث ستستخدم *
 .في برنامج الرسم لديك  فهو للجرافيك التي ستقوم بعملها gif أما امتداد *

.. إلخ في مجلد واحد وبعد ذلك قم بعمل ارتباطات إليها . .صفحات وصور  يجب حفظ جميع ملفاتك من -2
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   آيف ؟؟؟؟ ... تحدث مشاآل في ظهورها عند ارسالها إلى الشبكة وذلك حتى لا
عليك  لذلك يجب .. C:\mydocument\myweb يفترض فرونت بيج حفظ جميع صفحاتك في المجلد التالي ]

بالنسبة للصور  أما. قبل عمل اي ارتباط لها  myweb أن تضع جميع ملفاتك التي ستستخدمها في مجلد
تضع الصور والجرافيك فيها  لذلك يفضل أن images وهو myweb فيفترض فرونت بيج لها مجلد داخل مجلد

وبعد ذلك  c:\mydocument\myweb\images أي ستحفظها في.. خاصة اذا آان موقعك به عدد آبير منها 
وبذلك يكون مسار استخدامها صحيح.. آما تعلمت في السابق  نع لها ارتباطتقوم بإدراجها في الصفحة أو تص

 . [ بدون مشاآل بمشيئة االله وتظهر عند ارسالها للشبكة
 :الصفحة في الجهاز بعد عملها  طريقة حفظ *

 :التالية  ستفتح لك النافذة Save واختر File افتح القائمة

 
آما يمكنك تغيير عنوان الصفحة الذي حددته مسبقا في .. اسم الصفحة  اآتب File name في الخانة

 Save فوق اسم الصفحة بعد ذلك اضغط Change هذه النافذة وذلك بالضغط على خصائص الصفحة من
 .آما ذآرنا آنفاً myweb امج حفظها في مجلدالبرن ستلاحظ أن

 ** ملاحظات مهمة **
عنوان موقعك في  وذلك حتى تظهر مباشرة عند آتابة Index يجب أن يكون اسم الصفحة الرئيسية -1

 .المتصفح دون الحاجة إلى آتابة اسم هذه الصفحة 
المعروفة والموجودة في لوحة ن الرموزيجب أن تستخدم الحروف اللاتينية لكتابة اسم الصفحة أو أي رمز م -2

 . المفاتيح ولا تستخدم حروف عربية أو رموز غريبة

 في الشبكة ؟؟؟ آيف سيكون مسار ملفاتي #
هذا المسار  c:\mydocument\myweb الذي مساره myweb قمت بحفظ ملفاتك في مجلد أنت في جهازك

ترتيبها  وستنقل ملفاتك إلى الشبكة بنفس ، www. hi4net.com باسم موقعك أي سيصبح مثلا سيستبدل
لذلك ستقوم بإنشاء  .. images فمثلاً أنت لديك مجلد تحفظ فيه جميع صور موقعك وهو باسم.. في جهازك 

أما بالنسبة للملفات . المستخدمة  مجلد بنفس الاسم في موقعك في الشبكة وتضع فيه جميع الصور
أو مستند وورد ، أو غيرها فأنت  ، (.htm) تتميز بامتداد بعملها والتيالأخرى مثل صفحات الويب التي قمت 

لذلك سترسلها إلى الشبكة  .. images جنباً إلى جنب مع مجلد myweb وضعتها في جهازك في مجلد
 . وبذلك لن تحدث مشاآل في فتح الارتباطات على الشبكة بمشيئة االله .. images بجانب مجلد

  الثاني انتهى الدرس
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 الدرس الثالث
 

  :٢٠٠٠في فرونت بيج  آيف تتعامل مع الجداول #
 

بجانب  فمن غير الجداول لن تستطيع توسيط نص... صفحتك يجعل منها اآثر تنظيماً واحترافاً  استخدام الجداول في
حن نصحك باستخدام ن لذلك. إلخ ... صورة أو تضع نصوص على شكل أعمدة متجاورة أو تضع خط رأسي أو أو 

 !!الجداول في صفحتك واتقانها 
 :والآن ابدأ باستخدام الجداول  #

واختر عدد ) راجع شرح الرموز في الخطوة الأولى  ) اضغط على رمز ادراج جدول في شريط الأدوات العلوي
 .وحدد عدد الخلايا  insert>table استخدم أو. الأعمدة والصفوف التي تريدها 

 (Preview) فماذا لو آنت تريد حدود الجدول مخفية في.. حدود الجدول الداخلية والخارجية بارزة  ستلاحظ أن *
 !! بسيطة... للتعامل معها وتدرج ما تريد ؟؟  (Normal) وظاهرة في قسم

ذة ستفتح لك ناف Table Propeties ضع المؤشر في أي خلية داخل الجدول وانقر يمين الفارة ستفتح قائمة اختر منها
 : توضح خصائص الجدول وهي آالتالي

 
 .لتحديد موضع الجدول في الصفحة  :(1)
 .لتحديد المسافة بين الخلايا  :(2)
 ، Border=0 في المتصفح وذلك بوضع قيمة سمك الإطاراخفاء حدود الجدول  من هذا الخيار يمكنك :(3)

 .أيضاً زيادة سمك الإطار  ويمكنك من هنا
 .الخلايا  لاختيار لون الإطار حول :(4)
 .لاختيار لون خلفية للجدول  :(5)
 .لاختيار صورة آخلفية للجدول  :(6)
 .خلايا الجدول  لاختيار عرض وارتفاع :(7)
يمنكنك جعل خلايا الجدول وآأنها  Dark border و Light border ن من الخانتينباختيار لونين مناسبي :(8)
 . وهذا سيعطها مظهر جميل.. بارزة 

 . OK قم باختيار ما شئت من خصائص واضغط
 ** ملاحظة **

 . ( جميع خلايا الجدول أي اختيار ستختاره من خصائص الجدول سينطبق على )
 خلية واحدة أو مجموعة من الخلايا دون البقية ؟؟ الأمر بسيط معينة علىولكن ماذا لو أردت تطبيق خصائص 

..!! 
  .الخلايا  ولعدة خلايا قم بتحديد هذه.. لخلية واحدة ضع المؤشر بداخلها  -1
 :لك النافذة التالية التي توضح خصائص الخلية  ستظهر Cell Properties اضغط يمين الفارة واختر -2
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خصائص لتطبيقها على خلية واحدة أو خلايا  اختر منها ما تريد من.. آما تلاحظ أنها شبيهة بخصائص الجدول  -3

 . OK محددة ثم اضغط
 ** ملاحظة **

تصميمها وافتحها في  تها بشكل أفضل احفظ الصفحات التى ترى تعقيداً فيلفهم الجداول والتعرف إلى تعقيدا )
 . ( ٢٠٠٠الفرونت بيج 

  الثالث انتهى الدرس
 
 
 
 
 
 
 
 

 الدرس الرابع
 

  :٢٠٠٠فرونت بيج  حسّن مظهر صفحتك مع #
 أفقي في صفحتك ؟ آيف تضع خط: أولاً #

لكن ... الافتراضية  سيظهر لك الخط باعداداته Insert>Horizontal Line أفقي في الصفحة اذهب إلى لوضع خط
 آيف ؟.. يمكنك تغييرها حسب ما تريد 

 :الخط الأفقي عندها ستظهر لك النافذة التالية  انقر نقرة مزدوجة على
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  لون الخط : (3)   الخط سمك : (2)   طول الخط : (1)

 ما في صفحتك ؟ آيف تدرج رمز: ثانياً #
ثم  Insert اختر منها واضغط.. ستفتح نافذة بها عدد آبير من الرموز  Insert>Symbol اذهب إلى لإدراج رمز

 . Close اضغط
 

 ؟رقمي أو نقطي في صفحتك  آيف تضع تعداد: ثالثاً #
 فماذا تفعل ؟ ..لو آان لديك عدد من الأسطر وتريد ترقيمها أو وضع نقاط بجانبها بأي شكل آانت  أي
 . Enter+Shift فقط وليس Enter بينها بواسطتة اآتب السطور التي تريد ترقيمها واجعل الانتقال -1

ثم  واختر منها ما تريد Format>Bullest and Numbering التي تريد ترقيمها واذهب إلى ظلل السطور -2
 . الأسطر أصبحت صغيرة  ستجد أن المسافة بين .. OK اضغط

 
 متحرك في صفحتك ؟ آيف تدرج نص: رابعاً #

 :ستفتح لك النافذة التالية  Insert>Component>Marquee اذهب إلى

 
 .اآتب هنا النص المتحرك  :(1)
 .سرعة تحريك النص  :(2)
 . نوع الحرآة :(3)
 .لوضع لون لخلفية النص المتحرك  :(4)

 . Preview قم بمعاينته في قسم ... OK اختر ما تريد ثم اضغط
أجر تعديلاتك ثم .. ستظهر النافذة السابقة على النص المتحرك  لو اردت تغيير الاعدادات انقر نقراً مزدوجاً

 . OK اضغط
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 البوك مارك ؟ ما هي خاصية: خامساً #
خاصية  زرت موقع عندما تضغط على ارتباط ينقلك إلى مكان آخر ولكن في نفس الصفحة ؟ انها هل سبق لك أن

 : فكيف يتم عملها ؟ تابع الخطوات التالية فالعملية سهلة!! البوك مارك 
 .ارتباط معين  حدد النص أو الصورة التي تريد الزائر أن ينتقل إليها عند ضغط -1

 :التالية  ستفتح النافذة Insert>Bookmark اذهب إلى -2

 
 . OK ثم اضغط Bookmark name و الصورة في خانةاآتب اسم لهذا النص أ -3

 .هناك  حدد النص أو الصورة التي تريد الزائر أن يضغطها لينتقل إلى -4
 :التالية  ستفتح النافذة Insert>Hyperlink اذهب إلى -5

 
 ما يهمنا في هذه النقطة هذا جزء من النافذة فقط وهو

 قم باختياره موجود هنا) ٣(الذي آتبته في الخطوة  ستجد أن الاسم Bookmark افتح القائمة المنسدلة بجوار آلمة -6
 . OK ثم اضغط

 ٠ارتفاع الشاشة  رتباط والهدف أآبر منولكن لن يتضح لك إلا إذا آانت المسافة بين الا... المعاينة  قم بتجربته في

  ؟٢٠٠٠أزرار متغيرة بواسطة فرونت بيج  آيف تدرج: سادساً #
يمكنك عمل ... يتحرك أو يحدث له أي تأثير ؟  هل سبق لك أن زرت موقع عند مرور الفارة على زر يتغير لونه أو
 :آالتالي  2000 بعض هذه التأثيرات بواسطة فرونت بيج

 . لمؤشر في المكان الذي تريد ظهور الزر فيهضع ا -1
 :التالية  ستفتح النافذة Insert>component>Hover Button اذهب إلى -2
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 :حدد الخيارات التالية  -3

 .خانة اآتب النص الذي تريد ظهوره في الزر ال في هذه :(1)
 .التي تريد الزائر ينتقل إليها عند ضغط الزر  الصفحة :(2)

 . لون الزر :(3)
 .نوع التأثير  :(4)
 . عرض الزر :(5)
 .ارتفاع الزر  :(6)

 . Preview التأثير في قسم المعاينة ثم قم بتجربة ، OK وبعد ضبط الإعدادات اضغط
 ** ملاحظة **

 واضغط انقر الزر نقراً مزدوجاً على الزر ستفتح النافذة السابقة ثم قم بالتعديلات اللازمة لو اردت تغيير الاعدادات]
OK]. 
  الرابع انتهى الدرس

 
 
 
 
 
 
 
 
 

 الدرس الخامس 
 

، فيلزمك المتنوعة  ممن يملكون موقعاً آبيراً نسبياً على شبكة الإنترنت ، به العديد من الملفات إذا آنت **
 .وذلك بعمل مجلدات في موقعك. أن تكون هذه الملفات أآثر تنظيماً ليسهل إدارة موقعك فيما بعد

 ؟ ولكن آيف يتم تنظيم هذه الملفات داخل مجلدات في موقعك ##
 .لمحتوياته  عليك أولاً بتصنيف أقسام موقعك تصنيفاً ملائماً -1
 .محتويات هذا القسم  يدل علىبعد ذلك قم بعمل مجلد لكل قسم وسمه بما  -2
 : لنفترض أن لدينا موقعاً يضم الأقسام التالية: مثال  **

 .مجانية  قسم برامج -
 .مكتبة صور  -
 .مكتبة سمعية  -
 .قيم تعليمي  -

الافتراضي لملفات موقعك ، ونسمي آل مجلد  myweb  في مجلد مجلدات في الجهاز سنقوم بإنشاء أربعة
 :فمثلاً تكون أسماء الأقسام السابقة على التوالي ... ه على محتوا بما يدل

- software . 
- pictures 

- songs 
- edu 

 " ويمكنك إنشاء مجلد صور باسم. بحفظ آل صفحة في المجلد المناسب لها  وعند إنشاء الصفحات سنقوم
img " ، ًداخل آل من هذه المجلدات لحفظ الصور الخاصة بكل قسم  مثلا.  
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 : الارتباطات بين صفحات وملفات الأقسام عمل #
 وصفحة رئيسية ، index هذه المجلدات وباسم في البداية ستكون هناك صفحة رئيسية للموقع خارج -

index  قسم ( داخل آل مجلد( . 
ستكون  فكيف .... موقعك في صفحة الموقع الرئيسية بوضع ارتباطات لها وبالتأآيد ستشير إلى أقسام

  اطات ؟هذه الارتب
 :يمكنك عمل ذلك بإحدى طريقتين  edu الصفحة الرئيسية لقسم مثلاً ، لوضع ارتباط إلى : أولاً
   :بحيث يكون آالتالي  ، URL تسطير العنوان يدوياً في خانة )أ

 
 index الزائر بضغط هذا الارتباط سيقوم المتصفح تلقائياً بقراءة الصفحة الرئيسية وعندما يقوم . OK ثم ضغط

 . " edu " لهذا القسم
والتأشير  edu بحيث نقوم بفتح مجلد Create Hyberlink في استعراض هذه الصفحة من خانة الملفات )ب

  :آما في الشكل التالي  . OK نضغط بداخله ثم index على صفحة

 

 : عمل ارتباط لصفحة في قسم ما من صفحة في قسم آخر :ثانياً 
 wall.htm  أن نضع فيها ارتباط لصفحةنريد ، internet.htm باسم software لدينا صفحة في قسم :مثال  **

 :يمكنك عمل ذلك بإحدى طريقتين  . pictures في قسم
 :تسطير العنوان يدوياً  )أ

 .في الفرونت بيج  internet.htm افتح صفحة -1
 .ارتباط  اشر على العبارة أو الصورة التي تريدها أن تكون -2
 . Create Hyberlink افتح نافذة -3
  :اآتب ما يلي  URL في خانة -4

 
 . wall.htm والبقية وصول لصفحة ، software مجلد تعني خروج من/.. حيث أن  **
 . OK اضغط وأخيراً -5
 :ادخال العنوان أتوماتيكياً  )ب

 .في الفرونت بيج  internet.htm افتح صفحة -1
 .العبارة أو الصورة التي تريدها أن تكون ارتباط  اشر على -2
 . Create Hyberlink افتح نافذة -3
 .لاستعراض جميع محتوياته  pictures من الأعلى افتح مجلد -4
 . OK اضغط ثم wall أشر على صفحة -5
 .صفحات وملفات أقسام موقعك  ات بين جميعوبهذه الطريقة يمكنك عمل ارتباط **

في موقعك في الشبكة بنفس ترتيبها وأسماءها في جهازك ، وانقل صفحات آل  وأخيراً قم بإنشاء مجلدات ]
  . [ يماثله في الشبكة قسم إلى ما

 
 
 
 
 

 الدرس السادس
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 ماذا تعني الإطارات ؟ #
 .ملاحظ للشخص المتصفح  حة مستقلة ، ولكن بشكل غيرتعني تقسيم الصفحة إلى عدة أقسام آل منها يمثل صف

 .قائمة في اليمين ثابتة لا تتغير بتغير الصفحات في اليسار  وضع :مثل  *
  . [ مساويء ستعرفها عند استخدامك لها آما أن للإطارات ميزات فإن لها ] :ملاحظة  *

  ؟٢٠٠٠بيج  ما هي أنواع الإطارات التي يمكن عملها بواسطة الفرونت #
 . عدة أشكال جاهزة للفريمات ، يمكنك استخدام ما تريد منها ٢٠٠٠بيج  يوفر لك فرونت

 :مشاهدة هذه الأشكال آالتالي  ويمكنك
 . Page ثم New اختر File من قائمة -1

 . Frames سيفتح مربع حوار ، اختر من الأعلى -2

 
للفريمات ، يمكنك معاينتها في القسم الأيمن السفلي من مربع الحوار بالتأشير  ستظهر لك عدة أشكال -3

 . OK تريد ، وبعد الاختيار اضغط على ما
  :وإليك المثال التالي 

 
 . NewPage جديدة في أي إطار اضغط إذا أردت أن تنشيء صفحة -
 . Set initial Page جاهزة وتريد ظهورها في أحد هذه الإطارات فاضغط أما إذا آانت لديك صفحة -

 : آالتالي بعد ذلك قم بتحديد خصائص آل إطار على حده **
 .اضغط بيمين الفأرة على الإطار الذي تريد تحديد خصائصه -أ
 . Frame Properties من القائمة اختر -ب
  :مربع خصائص هذا الفريم آالتالي  سيظهر لك -ج
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 .الفريم  اسم هذا -1
 . عنوان الصفحة التي ستدرجها في هذا الفريم -2
 .عرض هذا الفريم  -3
 :شكل الإطارات باختلاف دقة العرض اتبع التالي  لكي لا يتشوه :ملاحظة  **

إذا آانت القائمة في اليسار والصفحة الرئيسية . فقط ، أيمن وأيسر  آما في الشكل السابق هناك اطاران
 بتحديد عرض إطار القائمة بالبكسل ، ونترك الآخر يتغير تلقائياً حسب دقة العرض ي اليمين فسنقومف

 .للمتصفح 
 . Relative ١الرئيسية نترآه   بكسل ، وعرض إطار الصفحة١٥٠نجعل عرض القائمة  :مثلاً  -

 . الأسفل تحتاجه إلا إذا استخدمت إطارات في الأعلى أو في ارتفاع الإطار ، وهذا لن -4
 .يغير مقاسات الإطارات  قم بإزالة الإشارة من مربع التدقيق إذا آنت لا تريد لمن يتصفح موقعك أن -5
 .صفراً ، لإخفاء حدود آل الإطارات  Frame Spacing اضغط هذا الزر واجعل قيمة -6
 :خاص بأشرطة التمرير الرأسية والأفقية حيث أن  هذا الخيار -7

- If Needed : ور الشريط عند الحاجة له ظه. 
- Always : ظهوره باستمرار . 
- Never :  ًعدم ظهوره نهائيا. 

  . [ وبنفس الطريقة يمكنك تحديد خصائص الفريم الآخر ]
 ##  ) :الفريمات ( في الصفحات التي تستخدم الإطارات  آيفية وضع الارتباطات

فيه الصفحة عند ضغط  الذي ستفتح) الفريم ( طار عند استخدامك لطريقة الإطارات يجب عليك تحديد الإ
 :ارتباط ما ، وذلك آالتالي 

 .العبارة أو الصورة التي تريدها أن تكون ارتباط  أشر علة -1
 . Create Hyberlink افتح نافذة -2
  . URL في خانة اآتب الارتباط الذي تريده -3

 
  : سيظهر لك الشكل التالي ، Target Frame اضغط على على زر -4
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 المناسبة من الخانة أو من اختيار العبارة. بالتأشير بالفأرة  (1) الصفحة من الخانة يمكنك اختيار مكان فتح **

 :حيث  ، (2)
Page Default [main : لفتح الصفحة في الإطار الافتراضي المسمى main . 

Same Frame :  فتح في نفس الإطار. 
Whole Page ,Parent Frame :  صفحة آاملة ( فتح في إطار آامل. ( 

New Window : جديدة ، بحيث تبقى الصفحة الأولى مفتوحة  فتح في نافذة. 
  . OK اضغط وأخيراً -5

 
حسن بن عبد القادر رشو: إعداد   
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